
 Worksheets 

1. Uses of Computer

A. State whether the following statements are true or false.

 1. A computer can work for long hours with the same speed and accuracy.

 2. Hardware can work on its own.

 3. There are three types of software.

 4. Computers are used in schools to maintain medical records and treatment details of patients.

 5. Computers are used in offices to communicate using e-mails.

B. Fill in the blanks.

 1. A computer is a machine that works on the principle of ________ cycle.

 2. _____________ software is the manager of a computer system.

 3. Computers are used in _____________ for checking records of books issued and returned.

 4. Computers are used by _________ to design cars, scientific apparatus and equipments.

 5. Computers are used in shops to keep records of ________ sold.

C. Match the columns.

  Column A  Column B

 1. Input device (a) Monitor

 2. Storage device (b) CPU

 3. Output device (c) Keyboard

 4. Processing device (d) Pen Drive

D. Answer the following questions.

 1. Define computer hardware.

 2. State the use of computers in libraries.

 3. Differentiate between input device and output devices.

 4. Why do we use computers in banks?

 5. State any three features of a computer.



Answers to Worksheet

A. 1. True   2. False

 3. False   4. False

 5. True

B. 1. IPO   2. System

 3. libraries   4. engineers

 5. items

C. 1. (c)   2. (d)

 3. (a)   4. (b)

D. 1. The parts of a computer system that we can see and touch are called computer hardware.
 2. Computers are used in libraries for various purposes as listed below.
 • Access library’s computerised books’ database.
 • Check records of books issued and returned.
 • Access online research articles and journals.
 3.

 4. We use computers in banks for the following purposes.
 • Operate ATMs and provide Internet banking facilities.
 • Keep records of account holders and their transactions.
 • Do online enquiry of a customer’s account balance.
 • Update the account balance, calculate interest and verify the cheques of customers.
 5. The three features of a computer are listed below.
 •  Speed: As compared to humans, a computer works very fast and does a large number of 

calculations quickly.
 •  Accuracy: A computer always gives correct results. Errors are reported due to incorrect 

data or instructions from the user.
 •  Versatility: A computer performs a variety of tasks. Hence, it is also known as a multitasking 

machine.

Input Devices Output Devices
These devices are used to provide input to 
the computer.

These devices are used to give the processed 
output.

Examples include keyboard, mouse and 
scanner.

Examples include monitor, printer and 
speaker.



2. Generations of Computers

A. State whether the following statements are true or false.

 1. Second generation computers were used between 1940 and 1956.

 2. In second generation computers, transistors were soldered to circuit board.

 3. Third generation computers were used between 1964 and 1975.

 4. The technology used for fourth generation computers is artificial intelligence.

 5. Keyboards were used to input data and monitors were used as output device for third 
generation computers.

B. Fill in the blanks.

 1. Computers are classified into different ____________ based on the technologies used to 
design them.

 2. High-level programming languages like COBOL and BASIC were developed in _________ 
generation.

 3. _______________ were used instead of transistors in third generation computers.

 4. _______________ were used in fourth generation computers.

 5. The fourth generation computers led to the development of _____________________.

C. Match the columns.

  Column A  Column B

 1. Second generation (a) 1975–Present 

 2. Fourth generation (b) 1964–1975 

 3. First generation (c) 1956–1964 

 4. Third generation (d) 1940–1956 

D. Choose the correct answer.

 1. Which of the following is an example of first generation computers?

 (a) ENIAC 1401   (b) IBM 360

 (c) HP 9000   (d) EDVAC

 2. Which of the following were used in second generation computers?

 (a) Integrated circuits   (b) Transistors

 (c) Vacuum tubes   (d) Microprocessors

 3. Which of the following were used in fourth generation computers?

 (a) Integrated circuits   (b) Transistors

 (c) Vacuum tubes   (d) Microprocessors



 4. Which of the following is an example of third generation computers?

 (a) ENIAC 1401   (b) IBM 360

 (c) HP 9000   (d) EDVAC

 5. Which of the following generation of computers led to the development of personal 
computers?

 (a) First generation   (b) Second generation

 (c) Third generation   (d) Fourth generation

E. Answer the following questions.

 1. State the features of first generation computers.

 2. Write a short note on ENIAC.

 3. Name the technology used in fourth generation computers and give examples.

 4. State the features of third generation computers.

 5. Describe fifth generation computers.



Answers to Worksheet

A. 1. False 2. False 3. True 4. False 5. True

B. 1. generations   2. second

 3. Integrated circuits   4. Microprocessors

 5. personal computers 

C. 1. (c) 2. (a) 3. (d) 4. (b)

D. 1. (d) 2. (b) 3. (d) 4. (b) 5. (d)

E. 1. Some features of first generation computers are listed below. 
 • They were very heavy and large in size.
 • They were expensive and slow.
 • They consumed a lot of electricity which generated a lot of heat.
 • Their programming capacity was very low.
 • Inputs were given in the form of punched cards and paper tapes.

 2. ENIAC was the first generation computer. It stands for Electronic Numerical Integrator and 
Computer. It was invented by John Presper Eckert and John W. Mauchly in the year 1946. 
Some features of ENIAC are listed below.

 • Weighed more than 27,000 kilograms
 • First programmable general-purpose electronic digital computer
 • Capable of solving a wide range of numerical problems
 • Had no stored programs

 3. Microprocessors were used in fourth generation computers. IBM 4300, ICL 2900 and HP 9000 
are some examples of the fourth generation computers.

 4. Some features of the third generation computers are as follows.
 • They were smaller, cheaper, faster and more accurate than second generation computers.
 • These computers could execute any type of application and were called general-purpose 

computers.
 • Keyboards were used to input data and monitors were used as output device.
 • They had more storage capacity.

 5. Fifth generation computers are still in development stage, though applications like voice 
recognition are being used today. The technology used for this generation is artificial 
intelligence which is the ability of computers to think and act like humans. The goal of fifth 
generation computing is to develop devices that respond to natural language input and are 
capable of learning and self-organisation.

  Some of the features of the fifth generation computers are as follows.
 • They are able to think and take decision like humans.
 • They are intelligent like human beings.
 • They are used in areas like robotics and defence.



3. Computer Memory and Storage Devices

A. State whether the following statements are true or false. 

 1. A computer stores data and instructions in the form of binary digits—0 and 1. 

 2. A group of 8 bits forms a nibble. 

 3. Primary memory is also known as the external memory. 

 4. PROM refers to Programmable Read Only Memory. 

 5. Secondary memory is used to store information for a longer period of time. 

B. Fill in the blanks.

 1. 0’s and 1’s are used in a programming language called ________ language.

 2. Computer memory is of ______ types.  

 3. ROM is a type of memory in which the information can only be ________. 

 4. _________ refers to read and write memory.

 5. A typical CD is ____ cm in diameter. 

C. Match the columns.

  Column A  Column B

 1. Hard Disk (a) Sores up to 128 GB of data 

 2. CD (b) Store 1GB, 2GB or more data

 3. DVD (c) Store data ranging from 4.7 GB to 8.5 GB 

 4. Pen Drive (d) Store 600 to 750 MB data 

 5. Blu-ray Disk (e) Store up to 8 TB of data

D. Name the following.

 1. Name the smallest unit of information.

 2. What is a group of 4 bits called?

 3. What is a group of 8 bits called?

 4. Name the type of ROM that can erase its stored information by exposing it to ultraviolet light.

 5. What is the other name of a pen drive?

E. Answer the following questions.

 1. Define primary memory.

 2. How is EPROM different from EEPROM?

 3. Write a short note on RAM.

 4. Differentiate between CD-R and CD-RW.

 5. Write a short note on hard disk.



Answers to Worksheet

A. 1. True 2. False 3. False
 4. True 5. True
B. 1. binary  2. two  3. read
 4. RAM  5. 13 
C. 1. (e) 2. (d) 3. (c)
 4. (b) 5. (a)
D. 1. Bit 2. Nibble 3. Byte
 4. EPROM 5. Flash drive
E. 1. Primary memory is also known as the internal memory or main memory. It is the inbuilt 

memory present inside the CPU. It stores data or instructions currently used by the computer. 
The minimum size of primary memory is 256 MB. We can increase its size any time. Primary 
memory is of two types—Read Only Memory (ROM) and Random Access Memory (RAM).

 2.

 3. Random Access Memory (RAM) refers to read and write memory. We can read information 
from it as well as write/store instructions on it. In RAM, the memory stores information in 
the form of electric signals. RAM is volatile in nature. CPU can access RAM as long as the 
computer is switched ON. As the power to the computer is switched OFF, the stored data and 
instructions disappear from RAM.

  RAM is small, in both physical size and the amount of data it can store. It is much smaller than 
a hard disk. A typical computer may come with 256 million bytes of RAM and a hard disk of 
40 billion bytes. RAM comes in the form of discrete (separate) microchips.

 4. 

 5. Hard disk is the main storage medium for computers. It is fixed inside a CPU box and is 
capable of storing a large amount of data. Hard disk can store up to 8 TB of data. It is made 
up of many rigid metal plates coated to store data magnetically. A hard disk rotates while it is 
being recorded.

EPROM EEPROM
It refers to Erasable Programmable Read 
Only Memory

It refers to Electrically Erasable Programmable 
Read Only Memory

We can erase its stored information by 
exposing it to ultraviolet light. EPROMs are 
cheap, reliable and hence widely used.

The information written on it can be erased 
using electrical signals.

CD-R CR-RW
It stands for Compact Disk-Recordable. In 
this type of CD, data once written cannot 
be changed or deleted, it can only be read.

It stands for Compact Disk-Rewritable. Data 
written on this CD can be erased. New data 
can be written or recorded many times.



4. More about Windows 10

A. State whether the following statements are true or false.

 1. A computer needs on an operating system to operate. 

 2. The window that appears on the monitor when we switch on a computer is called a screen 
saver. 

 3. Tiles are available in two different sizes. 

 4. A small jump arrow present at the lower left corner of the icon indicates that it is a shortcut. 

 5. Photos app displays the local time of the current location. 

B. Fill in the blanks.

 1. ___________ is an operating system that acts as an interface (Graphical User Interface) 
between the user and the hardware.

 2. A long horizontal bar present at the bottom of the desktop is called ___________.

 3. The Notification Area is seen on the _______ side of the Taskbar.

 4. A ___________ is an icon which provides a quick method to open any application.

 5. ___________ app provides minimum and maximum temperature of the location selected by 
you.

C. Match the columns.

  Column A  Column B

 1. Start button (a) Creates multiple desktops at the same time

 2. Search box (b) Shows programs that are open

 3. Task View button (c) Includes utilities like Battery and Volume

 4. Middle section (d) Displays a list of options

 5. Notification Area (e) Searches both the computer and the web

D. Choose the correct answer.

 1. Which of the following helps us to connect and browse the Internet?

 (a) Internet Explorer   (b) Recycle Bin

 (c) Network    (d) Shortcut icons

 2. Which of the following displays the most popular universal apps in the form of resizable live 
tiles?

 (a) DOS   (b) Linux

 (c) Unix   (d) Windows 10

 3. Which of the following allows us to manage all our mail accounts at one place?

 (a) Photos app   (b) Mail app

 (c) Weather app   (d) Alarms and Clock app



 4. Which of the following is present at the bottom left corner of the taskbar?

 (a) Notification Area   (b) Task View button

 (c) Start button   (d) Search Box

 5. Which of the following refers to the small pictures on the desktop?

 (a) Graphics   (b) Icons

 (c) Buttons   (d) Bullets

E. Answer the following questions.

 1. Define booting.

 2. What are live tiles? Write the steps to pin tiles to Start menu.

 3. How can you display multiple windows at a time?

 4. State the difference between Weather app and Alarms & Clock app.

 5. Write a short note on Mail app.



Answers to Worksheet

A. 1. True    2. False
 3. False   4. True
 5. True
B. 1. Windows   2. Taskbar
 3. right    4. shortcut
 5. Weather
C. 1. (d) 2. (e) 3. (a)
 4. (b) 5. (c)
D. 1. (a) 2. (d) 3. (b)
 4. (c) 5. (b)
E. 1. When we switch on a computer, it takes some time to start. This happens because the 

operating system of the computer is loading in its memory. This process is called booting.
 2. Windows 10 displays the most popular universal apps in the form of resizable live tiles in the 

right pane of the Start menu. These tiles display the latest updates such as news and weather 
report. We can pin the desired tiles to the Start menu by following the given steps.

  • Click on the Start button.
  • Right-click on the app that you want to add to the ‘Start’ menu.
  • Select the option Pin to Start. The selected app is displayed on the right pane in the form 

of a tile.
 3. We can follow these steps to open multiple windows at the same time.
  • Open any two applications like Excel 2016 and Word 2016.
  • Right-click on the blank portion of the ‘Taskbar’.
  • Click on Show windows side by side option from the menu. You will observe that both 

the windows will be displayed side by side.
 4.

 5. Mail app allows us to manage all our mail accounts at one place. It gives us notification 
regarding any incoming mail. We can read mails and respond to a sender through this app. 
We need to sign in with an account to use this app.

Weather App Alarms & Clock App

Weather app provides minimum and maximum 
temperature of the location selected by you. 
It also displays the weather forecast for the 
upcoming few days.

Alarms & Clock app displays the local 
time of the current location. We can also 
set the time and use stopwatch. It also 
allows us to set the alarm.



5. Paragraph Formatting in Microsoft Word 2016

A. State whether the following statements are true or false.

 1. Formatting can be applied using the Home tab. 

 2. Align left places the selected text towards the right margin. 

 3. There are four types of alignment that Word 2016 provides. 

 4. Within margins, we cannot increase or decrease the indentation of a paragraph or a group of 
paragraphs. 

 5. Numbers are normally used for points that do not necessarily have a particular order, such as 
in a list of vegetables. 

B. Fill in the blanks.

 1. _____________ means changing the appearance of a document to make it look more 
presentable and attractive.

 2. ___________ is the vertical distance between the lines of the text.

 3. ____________ determines the distance of the paragraph from either the left or the right 
margin.

 4. ____________ means arranging the selected text in alphabetical and numerical order.

 5. ____________ alignment places the selected text evenly between the left and right margins.

C. Name the following.

 1. Name the shortcut key used to align the text to the left of the margin.

 2. Name the shortcut key used for justify alignment.

 3. Name the key used to remove the bullets or numbers.

 4. What determines the width of area where the text is to be typed?

 5. Name the shortcut key used to align the text in the center.

D. Answer the following questions.

 1. Describe bullets and numbering. Write the steps to apply bullets.

 2. Write the steps to change line spacing.

 3. Differentiate between center and justify alignment.

 4. Write the steps to create a border around a paragraph.

 5. Define sorting. Write the steps to sort a list.



Answers to Worksheet

A. 1. True  2. False 3. True  4. False 5. True
B. 1. Formatting 2. Line spacing 3. Indentation
 4. Sorting 5. Justify
C. 1. Ctrl + L 2. Ctrl + J 3. Backspace key
 4. Margins 5. Ctrl + E
D. 1. Bullets and numbers are used to distinguish a list of points from the rest of the text. Bullets 

are normally used for points that do not necessarily have a particular order, such as in a list of 
vegetables. Numbers are usually used where the points have to be in a particular order, such 
as in a list of steps to perform a task.

  Follow these steps to apply bullets to the text.
  • Select the text.
  • Click on the Bullets button in the ‘Paragraph’ group of the ‘Home tab’.
  • Select the desired option.
 2. Follow these steps to change line spacing.
  • Select the paragraph whose line spacing is to be changed.
  • Click on the Line and Paragraph Spacing button in the ‘Paragraph’ group of the ‘Home’ 

tab.
  • Click on the required line spacing option from the drop-down menu. The space between 

the lines will adjust accordingly. 
 3.

 4. Follow these steps to create a border around a paragraph.
  • Select the text.
  • Click on the down arrow key of the ‘Border’ button in the ‘Paragraph’ group of the ‘Home’ 

tab. A box containing border options will appear in the drop-down menu.
  • Click on the desired border option to make a border around the selected text.
  • We can give different shades to the selected text by clicking on the down arrow key of 

the ‘Shading’ button in the ‘Paragraph’ group of the ‘Home’ tab. A ‘Theme Colors’ box 
appears. Select the desired colour to shade the selected text.

 5. Sorting means arranging the selected text in alphabetical or numerical order.
  To sort a list, follow the given steps.
  • Select the items to be sorted.
  • From the ‘Paragraph’ group of the ‘Home’ tab, click on the Sort button. A ‘Sort Text’ box 

appears.
  • Choose from the given options and click on the OK button. The text will get sorted.

Center Alignment Justify Alignment
It places the selected text in the centre of the 
left and right margins.
It is specially used for text headings.

It places the selected text evenly between 
the left and right margins.



6. Advanced Features of Word 2016

A. State whether the following statements are true or false.

 1. The 3-D Rotation effect gives a two dimensional appearance to an object. 

 2. A WordArt inserted in a document cannot be moved from one place to another. 

 3. A picture can be inserted in a document only from a file saved on the computer and not from 
the Internet. 

 4. The intersection of a row and a column is called a cell. 

 5. Sorting cells means to combine a number of cells into one cell. 

B. Name the following.

 1. Name the button on the Arrange group of the Format tab that is used to move the WordArt 
from one place to another.

 2. Name the setting that determines the relation between the position of the text and the 
picture.

 3. What are the vertical cells in a table called?

 4. Name the way of creating a visual presentation of facts and information.

 5. What are the pictures available on the Internet called?

C. Match the columns.

  Column A  Column B

 1. Tab Key/Right Arrow (a) Intersection of a row and a column

 2. Shift+Tab/Left Arrow (b) Arrangement of text in the form of rows and columns 

 3. Delete key (c) Move backward from one cell to another

 4. Table (d) Deletes WordArt 

 5. Cell (e) Move forward from one cell to another 

D. Choose the correct answer.

 1. Which of the following groups contain the WordArt button?

 (a) Editing group   (b) Text group

 (c) Paragraph group   (d) Style group

 2. Which of the following tabs contain the Shape Styles group?

 (a) Design tab   (b) Format tab

 (c) Home tab   (d) View tab

 3. Which of the following refers to the horizontal cells in a table?

 (a) Columns   (b) Cell

 (c) Rows   (d) Graphic



 4. Which of the following groups allow us to insert shapes in a Word document?

 (a) Links group   (b) Tables group

 (c) Illustrations group   (d) Text group

 5. Which of the following tabs allows us to insert SmartArt?

 (a) Home tab   (b) Insert tab

 (c) References tab   (d) View tab

E. Answer the following questions.

 1. Write the steps to edit a WordArt text.

 2. Write the steps to insert a picture from the Internet.

 3. How will you format a shape?

 4. How will you merge cells in a table?

 5. Define SmartArt. How can we insert SmartArt?



Answers to Worksheet

A. 1. False   2. False 3. False
 4. True 5. False
B. 1. Position button   2. Text Wrap    3. Columns
 4. SmartArt    5. Online Pictures 
C. 1. (e) 2. (c) 3. (c)
 4. (c) 5. (b)
D. 1. (b) 2. (b) 3. (b)
 4. (c) 5. (b)
E. 1. Follow these steps to edit a WordArt text.
  • Click on the inserted WordArt to make the WordArt Drawing Tools appear.
  • Edit the text in the ‘Text’ box.
  • Click on the Format tab and make the desired changes.
  • Click away from the WordArt text to close WordArt.
 2. Follow these steps to insert a picture from the Internet.
  • Click on the Online Pictures option in the ‘Illustrations’ group.
  • ‘Bing Image Search’ box appears. Type your search in the ‘Search’ box. If you are connected 

to the Internet, you will see pictures on the screen.
  • Click on the desired picture and then click on the Insert button to insert it in the 

document.
 3. Follow these steps to format the shape.
  • Insert the shape in your document.
  • Select the required formatting options from the ‘Format’ tab. The style gets applied to 

the shape in a document.
 4. Follow these steps to merge cells.
  • Select the number of cells to be merged.
  • Right-click and select Merge Cells option from the ‘Shortcut’ menu that appears. 
  The selected cells get merged into one cell.
 5. SmartArt is a way of creating a visual presentation of facts and information. It helps to 

add several different types of useful diagrams to our document. The idea behind SmartArt 
diagram is to visually communicate the information. We can create list, process, cycle, 
hierarchy, relationship, matrix and pyramid diagrams using SmartArt. 

  Follow these steps to insert SmartArt.
  • Click on the Insert tab.
  • Click on the SmartArt in the ‘Illustrations’ group. A ‘Choose a SmartArt Graphic’ box 

appears.
  • Select the SmartArt diagram option to be inserted and click on the OK button.



7. More on PowerPoint Presentation

A. State whether the following statements are true or false.

 1. PowerPoint helps to present views through visual aids. 

 2. A placeholder has many round sizing handles around the edges which makes it larger or 
smaller. 

 3. Formatting is the way we present, organise and arrange a presentation. 

 4. We can select the Solid Fill option to fill the background of the slide with a pattern of specified 
colour. 

 5. The font size of titles should be at least 40 to 44 points. 

B. Fill in the blanks.

 1. A slide contains different types of boxes with dotted borders called the __________.

 2. The _________ command is used if we delete something by accident.

 3. ____________ of a slide helps to emphasise on different sections of a presentation.

 4. _____________ adds colour to the slide that fades or darkens from one side to other.

 5. The title should be _________.

C. Match the columns.

  Column A  Column B

 1. SmartArt (a) Inserts a picture from the hard drive 

 2. Chart (b) Inserts a table with X columns and Y rows 

 3. Text (c) Creates an organised diagram 

 4. Picture (d) Creates a chart based on a table of data 

 5. Table (e) For bulleted lists 

D. Answer the following questions.

 1. What are the benefits of PowerPoint?

 2. Write the steps to change the alignment of the text.

 3. Define Gradient fill.

 4. How can we delete a placeholder?

 5. Mention the do’s and don’ts of PowerPoint.



Answers to Worksheet

A. 1. True  2. True 3. True  4. False 5. False 
B. 1. placeholders   2. Undo  3. Background
 4. Gradient Fill    5. centred 
C. 1. (c) 2. (d) 3. (e) 4. (a) 5. (b)
D. 1. PowerPoint has the following benefits.
 • PowerPoint helps in preparing handouts, speaker notes and outlines.
 •  Data from Word, Excel, Paint, photos from a digital camera and sound effects can be 

incorporated in a slide in PowerPoint.
 • It helps to present views through visual aids.
 •  A presentation in PowerPoint can be presented or projected on a big screen by attaching 

a computer to the multimedia projector.
 2. Follow these steps to change the alignment of the text.
  • Select the text or placeholder.
  • Click on the Home tab.
  • Click on the desired button in the ‘Paragraph’ group to align the selected text.
 3. Gradient fill adds colour to the slide that fades or darkens from one side to other. There 

are many options available to give different effects to the gradient which we can access by 
clicking on the arrow in the Preset gradients, Type, Direction and Colour boxes.

 4. To delete a placeholder, click on the edge of the placeholder and press the Delete key.
  The placeholder deletes all the changes we have made, and reverts to its original size and 

location. On pressing the Delete key on the keyboard again, the placeholder is completely 
deleted from the slide. The Undo command is used if we delete something by accident.

 5. Do’s
 • The font size of titles should be at least 36 to 40 points. The title should be centred.
 •  A good thumb rule is to cut down the paragraphs to sentences, sentences to phrases, 

and phrases to keywords.
 • Each word or image should help to convey the message in the strongest way.
 • Make sure that you take approximately only one minute to explain each slide.
  Don’ts
 • Do not crowd your slides. Use normal case and not all caps.
 • Do not use more than eight words per line or eight lines per slide.
 •  Do not let sound, animation, and other effects become distracting. Use them only to 

focus on main points.
 • Do not include unnecessary information.
 •  Avoid hard-to-read colour combinations such as red/green, brown/green, blue/black, 

blue/purple. Aim for high contrast between background and text.



8. Working with Slide Objects

A. State whether the following statements are true or false.

 1. Shapes is a group of ready-made shapes. 

 2. Transition is a very easy way to create a slide show of our favourite pictures. 

 3. Sound can be inserted into a presentation in three ways. 

 4. Animation is the additional effect given to a PowerPoint presentation. 

 5. WordArt helps us to organise information systematically. 

B. Fill in the blanks.

 1. __________ are structures for presenting data in rows and columns.

 2. ___________ is a special effect that determines how a slide appears as it enters or leaves the 
screen.

 3. _________ can make the text look curved and wavy, and appear in various other forms.

 4. __________ is a placeholder to enter and modify text.

 5. There is an option available on the ____________ window to insert text.

C. Match the columns.

  Column A  Column B

 1. WordArt (a) Media group 

 2. Shapes (b) Text group 

 3. Shape effects (c) Images group 

 4. Photo Album option (d) Drawing group 

 5. Audio option (e) Illustrations group 

D. Name the following.

 1. Name the tab of Text Box tool.

 2. Name the tab of the Shape effects button.

 3. Name the button that is used for recording sound.

 4. Name the tab that is used for adding inbuilt animations.

 5. Name the effect that adds emphasis to important information on the slide.

E. Answer the following questions.

 1. Why do we use text box? Write the steps to insert a text box.

 2. How do we add text in a shape?

 3. What are tables? Why do we need them?

 4. Write the steps to add inbuilt animation effects.

 5. Write the steps to apply animations only to selected objects.



Answers to Worksheet

A. 1. True  2. False 3. False
 4. True 5. False 
B. 1. Tables 2. Transition  3. WordArt 
 4. Text Box 5. Photo Album 
C. 1. (b) 2. (e) 3. (d)
 4. (c) 5. (a)
D. 1. Insert tab   2. Home tab
 3. Record button   4. Transitions tab
 5. Animation effect 
E. 1. Text Box is a placeholder to enter and modify text. Sometimes we need to add more text than 

the area provided for it. Therefore, a Text Box is used.
  Follow these steps to add Text Box to a slide.
  • Click on the Insert tab.
  • Click on the Text Box tool in the ‘Text’ group.
  • Hold down the left mouse button while dragging the mouse diagonally towards right 

and release the mouse button. A rectangular box on the slide with a cursor inside it is 
displayed. Enter the text into it.

 2. Follow these steps to add text in a shape.
  • Right-click on the shape and select Edit Text from the ‘Shortcut’ menu.
  • The cursor appears inside the shape. Now type the text.
 3. Tables are structures for presenting data in rows and columns. They help us in the following 

ways.
  • Organise information systematically.
  • Highlight important points.
  • Enhance readability and grab reader’s attention.
 4. Follow these steps to apply inbuilt animation effects.
  • Select the slide that has to be animated.
  • In the ‘Transitions’ tab, select an animation effect from the ‘Transition To This Slide’ group.
 5. You can choose an animation effect to add to the selected objects by following the given 

steps.
  • Select the text or object that has to be animated.
  • Click on Add Animation in the ‘Advanced Animation’ group of ‘Animations’ tab.
  • Click on the desired animation effect from the various groups.



9. Microsoft Excel 2016

A. State whether the following statements are true or false.

 1. Word 2016 provides formulae for performing simple and complex calculations. 

 2. A worksheet is also called a workbook. 

 3. There are two types of data that can be entered in an Excel sheet. 

 4. We can perform various manipulations like selecting, moving and copying data entered in a 
worksheet. 

 5. We can remove an entry from a cell or a group of cells by using the Delete key. 

B. Fill in the blanks.

 1. Microsoft Excel 2016 is an ___________ software.

 2. A ______ is an intersection of a row and a column.

 3. A ________  is a group of continuous cells which form the shape of a rectangle.

 4. The _____________ feature fills cell data or series of data into a selected range of cells in a 
worksheet.

 5. __________ key moves the active cell highlight to first row of the spreadsheet.

C. Match the columns.

  Column A  Column B

 1. Numeric Data (a) Mathematical equations containing numbers 

 2. Text Data (b) Contains address of the cell

 3. Formulae Data (c) Shows the characters and formulas entered

 4. Formula Bar (d) Consists of numbers from 0 to 9 and symbols like +, –

 5. Name Box (e) Consists of alphabet, numbers, spaces and special characters

D. Name the following.

 1. Name the combination keys used to move the cell pointer to the first cell of the topmost row.

 2. Name the group of the Cut button from the Home tab.

 3. Name the cell that indicates that the current cell is active.

 4. What is the default name of a worksheet?

 5. Which sign is used to begin a formula in Excel 2016?

E. Answer the following questions.

 1. Discuss some features of Excel 2016.

 2. Write a short note on Ribbon.

 3. How can we use the AutoFill feature?

 4. How can we delete a cell entry in Excel 2016?

 5. Write the steps to save a Workbook.



Answers to Worksheet

A. 1. False   2. False
 3. False   4. True
 5. True
B. 1. application   2. cell
 3. range   4. AutoFill
 5. Page Up 
C. 1. (d) 2. (e) 3. (a) 4. (c) 5. (b)
D. 1. Ctrl + Home   2. Clipboard group 
 3. Active cell   4. Sheet 1
 5. (=) or equal to sign 
E. 1. Following are some features of Excel 2016.
 • It provides formulae for performing simple and complex calculations.
 • It helps to search data quickly and replace it instantly.
 •  Data can also be viewed in graphical form like charts. It also helps us to compare data 

effectively.
 • It also provides various formatting features to improve the appearance of data.
 2. The panel at the top of an Excel document is called the Ribbon. It has 7 tabs on it. They are 

Home, Insert, Page Layout, Formulas, Data, Review and View. Each tab is divided into groups. 
The groups are logical collections of features designed to perform specific functions to 
develop or edit spreadsheets. The most used features of groups are displayed on the Ribbon. 
To view additional features within each group, click on the arrow at the bottom right corner 
of the group.

 3. Follow these steps to use the AutoFill feature.
  • Fill data in two cells and select the cells.
  • Click on the Fill command in the ‘Editing’ group of the ‘Home’ tab.
  • Click on the Series option in the list.
  • Select AutoFill option under the ‘Type’ heading in the ‘Series’ box and click on the OK 

button. Now drag the selection till the cell you want to fill the data in.
 4. We can remove an entry from a cell or a group of cells by using the Delete key. If we want to 

remove group of cells, we click and drag the mouse pointer over the cells. It gets highlighted. 
Pressing the Delete key will remove the cell contents of the selected cells.

 5. Follow these steps to save a workbook.
  • Click on the File tab.
  • Click on the Save option. A ‘Save As’ dialog box appears.
  • Type the file name in the ‘File name’ box.
  • Click on the Save button. The file will be saved with an extension .xlsx.



10. Algorithms and Flowcharts

A. State whether the following statements are true or false.

 1. Algorithms can be easily converted into flowcharts and then into computer programs.  
 2. Each statement in an algorithm must be written within the same line. 
 3. Flowchart is dependent on a particular programming language. 
 4. There should be one Start box and one Stop box in a flowchart. 
 5. A diamond shows input or output of data. 

B. Match the columns.

  Column A  Column B
 1. Diamond (a) Used for any type of internal operation
 2. Parallelogram (b) Indicates start or end of a program
 3. Circle (c) Connects various sections of a flowchart
 4. Rectangle (d) Shows evaluation of a condition or statement 
 5. Oval (e) Shows input or output of data 

C. Choose the correct answer.

 1. Which of the following refers to the step-by-step instructions written in simple English 
language to perform a particular task?

 (a) Program   (b) Algorithm
 (c) Method   (d) Procedure
 2. Which of the following words is used to begin an algorithm?
 (a) Begin   (b) End
 (c) Start   (d) Stop
 3. Which of these shapes is used to show evaluation of a condition or statement in a flowchart?
 (a) Rectangle   (b) Circle
 (c) Diamond   (d) Triangle
 4. Which of the following is used to connect breaks in a flowchart?
 (a) Connector   (b) Process Box
 (c) Input Box   (d) Decision Box
 5. Which of the following indicates the direction of instructions in a flowchart?
 (a) Connector   (b) Flow Lines
 (c) Decision Box   (d) Process Box

D. Answer the following questions.

 1. Define algorithm. List the advantages of using an algorithm.
 2. List down the rules for drawing a flowchart.
 3. What are the disadvantages of a flowchart?
 4. Write an algorithm to reach home from school.
 5. Name any three symbols of a flowchart and also mention its use.



Answers to Worksheet

A. 1. True  2. False 3. False 4. True 5. False
B. 1. (d) 2. (e) 3. (c) 4. (a) 5. (b)
C. 1. (b) 2. (c) 3. (c) 4. (a) 5. (b)
D. 1. Algorithm is a step-by-step instruction written in simple English language to perform a 

particular task. The first step in generating a computer program is to understand the problem 
and put down the steps in a sequence to get the result.

  Algorithms are advantageous in the following way.
 • They are easy to understand, implement and modify.
 • They are independent of any computer language.
 • They can be easily converted into flowcharts and then into computer programs.
 2. Follow the given rules to draw a flowchart.
 • The direction of flowchart is either from top to bottom or from left to right.
 • There should be one Start box and one Stop box.
 • The arrow head indicates the flow of data.
 •  A connector is used to connect breaks in the flowchart. It also joins from one page to 

another.
 3. Some of the disadvantages of a flowchart are as follows.
 • Sometimes flowchart becomes complex and clumsy.
 • If a program is altered then the flowchart needs to be redrawn completely.
 •  As the flowchart symbols cannot be typed, reproduction of a flowchart becomes a 

problem.
 • The essentials of what is done can easily be lost in the technical details of how it is done.
 4. Algorithm 1: Going Home (Walking)
  Step 1: Leave classroom 
  Step 2: Turn right out of school building 
  Step 3: Walk 2.0 miles 
  Step 4: Turn left on street 
  Step 5: Go to the 6th house
  Algorithm 2: Going Home (Take the bus)
  Step 1: Go to the bus area 
  Step 2: Get in the right bus 
  Step 3: Go to house
 5. Start/Stop:  An oval shape indicates start or end of a program or algorithm.
  Process box:  A rectangle is used for any type of internal operation like data transformation 

and movement.
  Input/ Output box: A parallelogram shows input or output of data.



11. Introduction to Internet

A. State whether the following statements are true or false.

 1. URL is a program used to locate and display web pages. 

 2. A search engine helps to access the desired information from the Internet. 

 3. Internet can be used to book air/railway/ bus tickets sitting at home. 

 4. Posting letters is the fastest and cheapest means of communication. 

 5. We can use fake e-mail IDs. 

B. Fill in the blanks.

 1. MODEM stands for __________________________.

 2. __________ is a collection of one or more related web pages.

 3. E-banking is also called ____________.

 4. E-mail is an __________ message sent from one computer to another that can contain text, 
pictures and sound.

 5. Using ____________ letters while typing is considered as shouting on others.

C. Match the columns.

  Column A  Column B

 1. Internet (a) Sends and receives data 

 2. Telephone line (b) Google Chrome 

 3. ISP (c) Biggest network of computers 

 4. Web Browser (d) G-mail 

 5. E-mail (e) Airtel 

D. Name the following.

 1. What refers to buying and selling of various products online?

 2. What is the address of a web page called?

 3. What is the other name for online education?

 4. What is the individual page on the Internet called?

 5. Name a system of interlinked pages having a variety of information which can be accessed 
through Internet by people across the globe.

E. Answer the following questions.

 1. Define MODEM.

 2. What is E-banking? Why do we use E-banking?

 3. Write a short note on e-mail. Also list down its advantages.

 4. Define any three Internet terminologies.

 5. Describe e-learning.



Answers to Worksheet

A. 1. False   2. True  3. True  4. False  5. False
B. 1. Modulator-Demodulator 2. Website  3. online banking
 4. electronic    5. capitalised 
C. 1. (c) 2. (a) 3. (e) 4. (b) 5. (d)
D. 1. E-commerce   2. Uniform Resource Locator 
 3. E-learning   4. Web page
 5. World Wide Web
E. 1. A Modulator-Demodulator (MODEM) connects the telephone line with a computer. It 

translates the language that computers talk into a language that can travel across the phone 
lines and vice versa.

 2. E-banking is also called online banking. It allows customers to conduct financial transactions 
on a secure website. Using e-banking, any enquiry or transaction can be processed online 
without visiting the bank.

 3. An e-mail is an electronic message sent from one computer to another that can contain text, 
pictures and sound. E-mail is the fastest and cheapest means of communication. Most of the 
service providers offer e-mail account for free of cost. They charge money only if you want to 
use more space for mail box. You need to register, choose an e-mail ID and create a password 
to access e-mail service. Following are the websites that offer e-mail service.

 • www.gmail.com
 • www.outlook.com
 • www.yahoomail.com
 • www.rediff mail.com
  Some benefits of e-mail are listed below.
 • Fast: Messages are sent anywhere around the world instantly.
 • Cheap: Transmission of messages costs nothing.
 • Simple: It is easy to use. Initially you need to register to any of the e-mail services.
 •  Efficient: An e-mail can be sent to an individual person or a group of people at the same 

time.
 • Versatile: Messages are sent using e-mail that may contain text, pictures, audio or video.
 4. World Wide Web (WWW): It is a system of interlinked pages having a variety of information 

which can be accessed through Internet by people across the globe.
  Search Engine: It is a computer program that searches for information on the Internet. Google 

is the world’s most popular search engine.
  Web Page: The individual page on the Internet is called a web page. It contains information 

in form of text, graphics, audio and video.
 5. Internet is a great tool for education. Online education, also called e-learning refers to 

teaching or learning that takes place using a computer and an Internet connection. It allows 
learning at your own place by providing access to learning material any time.


